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IMPORTANT!  

1. This manual applies to SuperPro/7500.  

2. Make sure the software installation is completed before connecting the  

programmer to PC.  

3. Please read the manual carefully before using programmers.  

4. Please use Xeltek Adapters. Non‐Xeltek adapters will cause error  
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Welcome  
 

 

Welcome to the world of Xeltek SUPERPRO programmers. Xeltek has produced the  

SUPERPRO line of IC programmers since 1985. Our motto is to provide high value  

products at affordable prices. In the past 27 years, Xeltek has produced a string of  

highly popular and successful programmers including SUPERPRO, SUPERPRO II,  

SUPERPRO III, SUPERPRO V, SUPERPRO 680, SUPERPRO 8000, SUPERPRO 3000U, 

and SUPERPRO 9000 models.  
 

SUPERPRO 3000U is the first model to incorporate both PC connected and stand‐  

alone modes operations combined into one programmer. It is also the first programmer 

to break the barrier of 40,000 devices supported in the industry. SUPERPRO 3000U is by 

far the most popular IC programmer in the industry today.  
 

Pushing the barrier further, Xeltek is proud to announce the family of SUPERPRO  

7500 programmers. SUPERPRO 7500 retains all the good features of SUPERPRO  

3000U, but, in addition, it is designed to program today's large size devices efficiently 

and effectively. 

 

Feature Highlights  
 

 

• The SUPERPRO includes ultra high speed programming via 32bit RISC MCU  

device. This is especially suitable for programming high capacity NAND  

Flash devices  

 

• A 144 pin driver support is built-in to provide efficient programming of large  

pin count devices, an additional pin expander module is not necessary to  

program large pin-count devices.  

 

• The SUPERPRO operates with a PC for engineering purpose or in stand-  

alone mode, without a PC, for repeat production mode programming. This  

provides seamless migration from engineering to production.  
 

 

• The SUPERPRO communicates through a USB 2.0 port and operates on most  

Pentium‐based, IBM compatible desktop/notebook computers.  

 
• The SUPERPRO comes with a standard 48-pin DIP ZIF socket and supports  

optional socket adapters to accommodate PLCC, TSOP, SOIC, SOP, QFP,  

TSSOP and BGA package types.  
 

 

• The programmer and software supports Windows XP, Windows Vista, and  

Windows 7.  
 



 

 

 

•  For authorized users, the SUPERPRO can provide for automatic generation of  
 

electronic serial numbers. 

User Manual Organization  
 

 

This manual includes the following major chapters,  

• An introduction to the SUPERPRO series, including the system requirements  

and the software and hardware installation  
 

 

• Detailed explanations on the commands and the programming procedures  
 

• Information about error messages and common problems  
 

• An Appendix that includes the customer support information  

 
 
 
 

Note: The software prevails in any discrepancy between it and the user manual, due  

to any upgrades of the software. The information in this document may be subject to  
change without notice. 



 

 

 

 

Chapter 1 Overview of SUPERPRO® 7500  
 

 

This section provides a brief introduction of SUPERPRO (1.1), software features (1.2),  

structure of the handbook (1.3), system requirement for the installation (1.4), and  

package content (1.5).  

 
 
 
 

1.1 Introduction to SUPERPRO  
 

 

The SUPERPRO is a menu-driven software that operates a series of cost-effective,  

reliable, and high-speed universal programmers. SUPERPRO communicates  

through a USB 2.0 port and operates with most IBM-compatible desktop and  

notebook computers that based on Pentium. Menu-driven software interface makes  

all the operations quite user-friendly.  

 
 
 
 

1.2 Software feature  
 

 

The USB 2.0 Series supports:  
 

 

• Windows XP, Windows Vista, and Windows 7  

• More than 43,000 types of devices, including E/EPROM, PLD, MCU, FLASH,  

etc.  

• Compatible with many types of file formats, such as Binary, Intel (linear &  

segmented) Hex, Motorola S, Tektronix (linear & segmented), Jed, pof, etc.  

• It supports a plug-in test (48 pins or less) to detect defective chips, improper  

insertion and pins that are poorly contacted.  

• SUPERPRO has an integral full-screen buffer editorial environment with  

commands such as fill, copy, move, swap, etc.  

• Electronic serial numbers are generated automatically. 

1.3 Structure of this User's Guide  
 

 

The content of this User's Guide is structured into three major sections,  
 

 

Chapter 1 is an overview and introduction of the SUPERPRO, describing the  

system requirement, installation of the hardware and software.  
 



 

 

 

Chapter 2 - Chapter 5 are detailed specification and explanation of all the  

features, commands, and function modules.  
 

In Appendices, there are supportive information and guide for trouble-shooting  

 
 
 
 

1.4 System requirements  
 

 

The minimum system configuration requires:  
 

 

• A desktop or laptop computer with Intel Pentium or an equivalent processor  

• Windows XP, Windows Vista, and/or Windows 7 operating system  

• 1 GB free space on the hard drive  

• Standard (USB 2.0) compliant socket  

• A CD drive  
 

 
 

1.5 Package content  
 

 

A standard SUPERPRO programmer package includes:  
 

 

 A Programming host module  

 A Power supply unit  

 A USB 2.0 connection cable 

 A CD contains driver software  

  A user's registration form  



 

 

  

Chapter 2 System Installation  
 

 

This chapter provides a brief guidance on how to install the SUPERPRO software  

and connect the programmer hardware properly.  
 

 

NOTE: To avoid complications during the installation process, you must setup the  

software before connecting the programming hardware (the USB device) to your  

computer. That is, installation through the "Add New Hardware Wizard" of  

Windows system is NOT recommended (this might lead to wrong drivers with a  

different compatible device ID).  

 

2.1 Software Setup  
 

Select the software to setup your SUPERPRO programmer either from the CD‐  

ROM or by downloading the program from the Xeltek website. Instructions for both  

methods are described below.  
 

 
 

2.1.1 Software setup from CD  
 

1. Insert the CD into the CD-ROM drive.  

2. If the setup program does not start automatically, run SETUP.EXE located in  

the root directory.  

3. Select the appropriate programmer model.  

4. Click Setup.  
 

NOTE: Each model has its own software and they are NOT compatible.  
 

 
 

2.1.2 Download the software from website and setup (recommended)  
 

You can also download the specific software for a certain model at Xeltek  

website: http://www.xeltek.com. Select the icon to download the appropriate file for  

your programmer. Once you have saved the file to your computer, run it to setup  

the software. The following procedure describes the setup process step by step.  
 

1. Once the setup program is running, a dialog box displays to allow the user  

choosing a preferred language. Select one from the drop down list and click  

OK to continue 
 

http://www.xeltek.com/


 

 

 

 

2. An installation wizard will be displayed (as illustrated below). Click Next to  

continue.  

  

3. A License Agreement will be displayed. Click I Agree to continue.  



 

 

 

4. Choose the Destination Location in which the driver software will be  

installed. Once the destination file folder is selected, click Next to proceed.  

 

5. Another dialog box will be presented and allow the user to choose whether  

creating a start menu icon and/or a desktop icon. Once correctly check the  



 

 

tick box(es), click Next to continue.  

 

6. Check the previous selections and click Install to start the installation 

 

NOTE: If you are using the Windows Vista system, the operation system may  
 



 

 

display the following dialog box to ask you whether to install the software. Select  
 

Install this driver software anyway.  

 

7. Once the installation is completed, click Finish.  

 

2.2 Hardware and Driver Installation  
 

After you set up the software, you can install the hardware and driver. The  
 

following procedure explains the installation process.  
 

 

NOTE: Do not follow these steps below if you have not yet setup the software (see  
 

section 2.1).  
 



 

 

 
 
 

1. Make sure all other programs are closed during the installation process.  
 

2. Connect the programmer module to the computer through the USB port.  
 

3. Turn on the power switch of the programmer module.  
 

When you connect the new hardware, the system initiates the New Hardware  
 

Wizard, which locates the driver from the software you have just installed.  
 

The system displays alerts one at a time, illustrated below. The alerts on your  
 

system may be slightly different. 

 

 

 

 

 

 

 4. After you open the application software for the programmer, the system  
 

automatically starts the initialization. If it does not, make sure the  
 

programmer is securely connected to the computer and that the power switch  
 

is on.  



 

 

 

Chapter 3 Quick Guidance of the Software Features  
 

 

This chapter is a quick guidance of the SUPERPRO
®
 software. It describes the  

 

functions and features of the programmer that are most frequently used.  The  
 

SUPERPRO 7500 provides two programmers in one, they are: PC mode for engineering  
 

and Stand-alone mode for production.  
 

 

• Under PC hosted mode, a PC controls the programmer via a high-speed USB  
 

connection to program a chip.  
 

• Under stand-alone mode, the user controls the programmer via 20-characters,  
 

4-line LCD display with 6-KEY keypad.  
 

In this chapter, all the features being described are in PC mode, while the stand-  
 

alone mode is described elsewhere.  
 

 
 

3.1 The User's Interface (main screen)  
 

The main SUPERPRO screen is illustrated below. Each part of the user interface is  
 

labeled with a number and described below. 



 

 

 

1. The Menu Bar provides access to the File, Buffer, Device, Option, Project,  

and Help menus.  
 

2. The Tool Bar offers quick access to many commonly used functions.  
 

3. The Command Window enables shortcut to many commands and operations.  
 

4. The Programmer Statue Panel shows the state of the current project and  

programmer.  
 

5. The Device Panel shows the connected device.  
 

6. The Buffer Panel shows the state of the buffer.  
 

7. The File Panel shows some basic information of the loaded file.  
 

8. The Log Window displays the operation history.  
 

 
 

A detailed specification of the Programmer Statue Panel is shown in the picture below  
 

and described accordingly to the numbered notation.  
 



 

 

 

 

1. Module number and the ID of the programmer  
 

2. Auto/Cancel button  
 

3. Device name and the manufacturer information  
 

4. Statue bar shows the success/failure of the programmer  
 

5. Statistic information panel  
 

6. Count down settings and information  
 

7. Connectivity and progression of the programmer/project  
 

8. Serial number  

 

3.2 Programming Procedures  
 

This section provides information on steps for common procedures to programme  
 

devices using SUPERPRO 7500.  
 

 
 

Before using the programmer to program a device, make sure that the programmer  
 

is installed properly and that the computer and programmer are communicating  
 

successfully. Make sure that you have the appropriate adapter for your SMD devices,  
 

if applicable. Insert the chip correctly. Follow the guidelines of the standard chip  
 

insertion markings near the pin-driver socket. However, if you select SMD or a  
 

device that requires non-standard insertion, the system prompts you with the  
 

appropriate chip insertion.  
 

 



 

 

 

3.2.1  Select the device  
 

To open the Device Selection window, choose one of the following options:  
 

• Select the Device Selection icon  
 

• Select the Device menu and select the Select Device (Device) option.  
 

The system then displays the Device Selection screen as shown below.  

 

NOTE: The red device name means that such device(s) need authorization to use. 

3.2.2  Load data into buffer  
 

One can load data into the buffer by reading data either from a file or a master chip.  

 To read data from a file, select Load File from the File menu. The system  

displays the Load File dialog box. To make sure the loaded data is correct one  

can review the information in the Buffer window.  

NOTE: Some Hex or S record files contain non-zero file initial address. In this  

case, enter the start address in the File Address box.  

 To read the data from a master chip, complete the following steps:  
 

o Insert the master chip in the socket.  
 

o Select Read on the Device Operation window in the main screen. The  
 



 

 

data will be copied from the master chip to the buffer memory.  
 

o To make sure the loaded data is correct one can review the  
 

information in the Buffer window.  
 

o If desired, you can save the data to a disk for later use.  
 

NOTE: The read function is not available for some devices, including those  
 

have been encrypted. 

 

3.2.3 Set options 

 

 Click Operation Option from the Option menu to open the Operation Option  
 

screen. Set each of the following options:  
 

o Insertion Test indicates whether to check the pin contact.  
 

o Device ID Check indicates whether to check the ID of the device.  
 

o Beeper indicates whether the beeper alarms a sound when the  
 

operation succeeds/fails.  
 

o Auto Increment Function indicates an automatic increase in the label  
 

number written to each chip.  

o Address Change indicates whether a different start and end address  
 

shall be applied for the programming zone of the device.  
 

 To set the order of the batch processing functions, select Edit Auto from the  
 

Options menu. The system displays the Edit Auto screen.  
 

 For devices that include the configuration word, you must set the 
 

configuration word before programming to ensure that the chip can be used  
 

on the target system. The configuration words for some devices are contained  
 

in the data file. Therefore, the system automatically loads the configuration  
 

word into the configuration word buffer when loading the data file. For some  
 

devices, you must manually make the selection. Select Device Configuration  
 

Word from the Device menu to open the ConfigWord screen.  
 

 Many devices must meet some special requirements for the programming of  
 

a chip, including special algorithms conventions. Read the device manual or  
 

instructions carefully and adjust the operation steps or buffer data as needed.  



 

 

 

If an adapter is required for programming, the system displays information  
 

about the adapter in the device information screen. 

 

3.2.4 Execute programming 

 

Insert the chip properly into the socket. If the prompt information indicates a need  
 

for an adaptor, you may purchase the adapter. The operation procedure for the  
 

programming of a chip is described as the following steps:  
 

 Blank Check  
 

NOTE: You can skip this step if the chip is brand new.  
 

The Blank Check fails on electrically erasable chips containing some  
 

information. In this case, perform the Erase operation first. You do not  
 

need to erase EPROM chips for which the data can be overwritten.  
 

 Program  
 

 Verify  
 

NOTE: This step is necessary. The chip must pass Verification before the  
 

programming can be implemented. Some chips provide only the  
 

accumulation check function, such as VerifyCRC instead of a unit-to-unit 

check function. Very few chips do not provide the accumulation check 

function.  
 

 Security or Protect if encryption is required  
 

NOTE: You may need to set the configuration word before performing  
 

encryption. Refer to Device Configuration Word on page 37 for more  
 

information. Select Auto to finish all the operations in one step.  

 

 Execute Production Mode to Program Chips in Batches  
 

Select Production Mode from the Option menu to program devices in large 

quantities. This function facilitates the job of the user who programs chips in 

batches. In order to program chips in batches, the programmer always conducts the 

insertion test. The programmer waits for the chip insertion to initiate while the 

system displays the following prompt: Please, insert a device into the socket. Once 

you have properly inserted the chip, the auto batch-processing command starts 

automatically.  

 



 

 

 

 

 

3.3 Programming When Connected by Hub  
 

SUPERPRO
®
 7500 provides a connection hub and user can simultaneously operate  

 

multiple SUPERPRO
®
 7500 programmer by using the hub.  

 

 
 

Click menu Programmer -> Module Management, and select the number of the  
 

programmer you want to operate. Picture below shows the interface when  
 

simultaneously operating three programmers.  
 

 
 

Every programmer has a unique number. The programmer's first line of the LCD  
 

display will show the number of this programmer. The module that is selected at the  
 

time will be highlighted. The device that is going to be programmed can be different  
 

type(s) in each of the module that is connected through the hub.  

 



 

 

 

 

 

 

 

 In normal mode, all operations (i.e. selecting devices, loading documents and  
 

programming) are carried out in the programmer that is selected and  
 

highlighted at the time being. 

 In global configuration mode, all the operations are carried out in the  
 

programmer(s) that is selected with the check in tick-box(es).  

 

NOTE: Choose specified hub for XELTEK to connect SUPERPRO/7500, and  
 

currently up to 8 programmer can be operated simultaneously.  

` 

Chapter 4 Functions and Commands  
 

 

This chapter provides a detailed specification and explanation of the SUPERPRO®  



 

 

 

software. It includes the description of the functions and commands that is listed as  
 

below,  
 

 

• File Menu and Tool Bar (4.1)  
 

• Project Menu (4.2)  
 

• Device Menu (4.3)  
 

• Option Menu (4.4)  
 

• Tool Bar (4.5)  
 

• Log History Window (4.6)  

4.1 File Menu and Tool Bar  
 

 

The File menu provides access to the commands of Load, Save, Recent Projects, and  
 

Exit. Each function is described in the following sections.  
 

 
 

4.1.1 Load File  
 

There may be one or more data buffers in the device. If several data buffers are  
 

displayed after you have selected the device, refer to the name and the data manual  
 

for the meanings of the buffers. The two data types of the device are  Data  
 

(HEX/ASCII) and Fuse.  
 

 

• For most EPROM and SCM, the data type is Data (HEX/ASCII).  
 

• The data type for PLD device is Fuse.  
 

After you select the device, the software automatically will identify the data buffer  
 

type. You can review the buffer data types if you open the Edit dialog box for the  
 

data buffer. When some file data are loaded into the data buffer, the following rules  
 

apply:  
 

• With a HEX/ASCII data buffer (EPROM, MCU etc.), the system assumes that  
 

8 bits of the data are valid.  
 

• With a JEDEC buffer (PLD/PAL), the system considers the lowest bit (1 bit) of  
 

the file data valid.  
 

 



 

 

 

Select Load from the File menu to open the Load File dialog box, as illustrated  
 

below. The red labels refer to the numbered notations follow this figure. 

 

 

1. Buffer. To select the Buffer name from the drop down list. The system loads  
 

the file data into the buffer accordingly.  
 

2. File Name. To enter the name of the data file to load it, or you can select  
 

Browse and choose the file using the Select File box .  

3. File Type. To select the type of the file from a drop down list. Different file  
 

types are included here, e.g. Binary, Intel Hex, Motorola S record, JEDEC,  
 

POF, TI, etc.  
 

4. File Mode. To select one of the following File Modes from the drop down list:  
 

• Normal to load the whole file  
 

• Even to load the first byte and discard the second byte out of every  
 

two bytes  
 

• Odd to discard the first byte and load the second byte out of every  
 

two bytes  
 

• 1st byte of 4 to load first byte and discard the other three bytes out of  
 

every four bytes  



 

 

 

• 2nd byte of 4 to load the second byte and discard the other three bytes  
 

out of every four bytes  
 

• 3rd byte of 4 to load the third byte and discard the other three bytes  
 

out of every four bytes  
 

• 4th byte of 4 to load the fourth byte and discard the other three bytes  
 

out of every four bytes  
 

• 1st 2_byte of 4 to load the first two bytes and discard the other two  
 

bytes out of every four bytes  
 

• 2nd 2_byte of 4 to load the last two bytes and discard the other two  
 

bytes out of every four bytes  
 

5. Buffer Address. To indicate a different initial address of the data being  
 

loaded into the buffer.  
 

6. File Address. In case the file type has a non-zero start address, enter the data  
 

offset address in the File Address field. Make sure to enter the correct  
 

address, because an incorrect file offset address causes part of the buffer to be  
 

filled with FF (or incorrect data). 

7. Buffer clear on data load. Tick this checkbox will enable the user to fill the  
 

data buffers with the specified data.  
 

NOTE: Ticking the checkbox of Custom File will disable most loading option. 

 

 



 

 

 

4.1.2 Save File  
 

Select Save from the File menu to save data in the current buffer to a disk file. A  
 

dialog box titled as Save File will be displayed and the saving options are similar to  
 

those in section 4.1.1 Load File. 

 

 

1. Buffer.  
 

2. File Name  



 

 

 

3. File Type  
 

4. Buffer Address  
 

5. Data Size. To enter the save data size in number of bytes.  
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3. File Type  
 

4. Buffer Address  
 

5. Data Size. To enter the save data size in number of bytes.  
 

 
 
 

4.2 Project Menu  

The project file contains all of the information and preparations before programming.  
 

It can also be used to restore the working environment that has been saved  
 

previously. The project file includes:  
 

• The current device's information, such as:  
 

o Manufacturer  
 

o Device type  
 

o Pin size  
 

o Data file name  
 

o Current buffer data  
 

NOTE: The buffer data may differ from the data file due to revisions.  
 

• All Operation Option settings  
 

• The content of the Auto mode  
 

• Software module related to the project  
 

NOTE: The project content is related to the programmer software. If the software  
 

has upgraded or has been re-installed to another folder, the saved project files  
 

become ineffective 

4.2.1 Load Project  
 

Select Load Project from the Project menu to load a project file. Select the file in the  
 

File dialog box. Following the information that is provided by the project file, user  
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